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Introduction

Topics in this chapter:

■ Overview on page 1
■ About this Guide on page 2
■ Contacting Customer Support on page 3

Overview
Autodesk® WiretapCentral™ is a fully integrated Web application that provides interactive access to all media
assets in your facility network. It presents editorial, visual effects, and grading assets stored on any
network-accessible Stone® filesystem or standard filesystem framestore.

The intuitive Web interface eliminates the need to be at an Autodesk creative workstation to import, play,
encode media, or to submit and monitor background jobs. This allows the artist to offload media management
and transcoding, and stay focused on creative tasks.

WiretapCentral straddles several different technologies, including Autodesk Visual Effects, Finishing and
Colour Grading workstations, low-bandwidth Web video, and several different networking and collaboration
protocols and tools.

1
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WiretapCentral enables you to directly import REDCODE RAW and multi-channel OpenEXR files by leveraging
the Autodesk® Wiretap® Gateway.

When importing media, WiretapCentral can use Autodesk® Backburner™ distributed background processing
to maximize efficiency.

About this Guide
This guide provides information on using WiretapCentral and the related components.

Notation Conventions
A number of style conventions are used throughout your documentation. These conventions and examples
of their use are shown as follows.

ExampleConvention

install rpm -qaText that you enter in a command line or shell appears
in Courier bold. Press the Enter key after each com-
mand.

<filename>Variable names appear in Courier, enclosed in angle
brackets.

limit coredumpsizeFeedback from the command line or shell appears in
Courier.

/usr/discreetDirectory names, filenames, URLs, and command line
utilities appear in italics.

Related Documentation
Documentation for this release is installed with the product as PDF files and as an HTML help system, and
is also available on the Autodesk web site at http://www.autodesk.com/me-documentation. From this page you
can access the complete documentation library.

2 | Chapter 1   Introduction



You should also refer to the product release notes for all late-breaking release information.

Contacting Customer Support
For Autodesk Media and Entertainment Customer Support, visit http://www.autodesk.com/support.

Customer support is also available through your Autodesk reseller. To find a reseller near you, consult the
reseller look-up database at http://www.autodesk.com/resellers.

Contacting Customer Support | 3
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Using Wiretap Central

Topics in this chapter:

■ Overview on page 5
■ WiretapCentral User Interface on page 5
■ Browsing using the Network Tree on page 8
■ Browsing using Thumbnails on page 9
■ Browsing Using the List View on page 10
■ Using the Player on page 12

Overview
WiretapCentral presents a Wiretap® network as a hierarchy of hosts, volumes, projects, libraries, reels and
clips. When you first point a web browser to the WiretapCentral server, the network tree lists all hosts
detected on the network. Clicking on a host (which is the top-level data node) reveals its volumes, and so
on down the hierarchy, to clips.

The network tree works in conjunction with the main view area to give you a more complete picture of the
network and volume contents. Initially the main view area is empty. Once you start navigating a host, it
displays the contents of the host’s volumes, libraries, and reels, as you select them. By default it displays
thumbnails for each clip, but it can also display clip metadata in a list view mode.

WiretapCentral can browse volumes on Autodesk Visual Effects and Finishing workstations. With Wiretap
Gateway, it can browse volumes on Autodesk® Lustre® workstations and any storage device accesible on the
network.

NOTE Clips stored on a Finishing workstation’s EditDesk or a Visual Effects workstation’s Desktop are not accessible.

WiretapCentral User Interface
The user interface consists of three main areas, as shown in the following diagram.

2
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a b c

(a) Network tree  (b) Details area (c) Main view area

Network Tree
The network tree displays the contents of the Wiretap network in a tree hierarchy. Initially, it lists all the
hosts discovered. Expanding a host displays its volumes, and the projects and clip libraries within.

b
c

d
e
f

a

(a) Host (collapsed) (b) Host (expanded)
(c) Framestore (d) Project (e) Library (f)
Reel

Main View Area
The main view area occupies a central portion of the UI. It presents clip thumbnails, the list view, and the
player. Switch between these display modes using the View menu, or double-click a thumbnail to open the
player immediately.
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a b c

(a) Clip Thumbnail (b) Play/Pause button (c) Scroll Bars

Details Area
When you browse, the information for the node that you are currently on, whether server, volume, project,
library, or clip, is presented in the Details areas. This information persists until you select another node.

Changing the Layout
To change the layout of the user interface, select an option from the Layout menu.

ToSelect

Display the network tree, the main area, and the details area. If displaying the player on
higher-resolution monitors, this should be enough to show the whole frame.

Normal

Hide the details area, giving more space in the main area for thumbnails or list view items.Extended

Hide the network tree and the details area, leaving only the main area. This is most useful
when you need the most size in player mode.

Full Screen
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Browsing using the Network Tree
The network tree is an interactive tool for browsing the network and volume hierarchy. It works in conjunction
with the main view area to show clips as thumbnails or in a list view.

a b c

(a) Network tree with library selected (b) Draggable divider (c) Main view area showing
clip thumbnails

To browse the network:

1 Click any host item in the network tree to display its volumes. While multiple volumes can be present,
typically a host has just one volume — stonefs, for example.

Icons representing the volumes appear in the main view area, when in thumbnail mode.

NOTE When you expand an item in the network tree an animated cursor indicates that a metadata transaction
is taking place. Depending on the complexity of the tree, this can take some time.

2 Click a volume in the network tree to display its projects.

Icons for the projects appear in the main view area.

3 Click collapsed items to further expand the network tree.

■ The data structure hierarchy is exactly what you would find browsing a clip library in any Autodesk
Visual Effects and Finishing workstation.
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■ Once an item is expanded, you can collapse it again by clicking its expand/collapse arrow.

■ To switch between expanded items, click the item of interest. This changes the focus without
collapsing the deselected item.

4 To expand all an item’s selection at once, from the Selection menu, choose Expand Children.

5 To refresh the view, choose either Refresh All or Refresh Selection.

Using Bookmarks
Create and use bookmarks to keep track of frequently used locations by selecting an option from the
Bookmarks menu. You can choose to add a bookmark for the currently shown location, or to go to a previously
saved bookmark. You can also remove an unused bookmark.

Managing Libraries and Reels
You can create new libraries and reels in a project, on an accessible volume, by choosing the appropriate
option from the Tools menu. You can also add/remove directories on a Wiretap Gateway server. You can
also remove any clip, and some nodes, by using the Delete option.

NOTE The option that allows deleting is on by default but can be turned off in the configuration file, which is
found at /var/www/html/WiretapCentral/wiretapcentral.cfg. Under the Permissions section, uncomment the line:
DeleteEnabled=false.

Browsing using Thumbnails
By default, the main view area presents the Wiretap network and volume content as icons and thumbnails.
For example, if a library is selected in the network tree, the main view area displays icons for the reels it
contains. When you select a library or reel, thumbnails are generated for their clips. Once you have selected
a host in the network tree, you can do all of your downward browsing using icons and thumbnails.

To browse using thumbnails in the main view area:

1 Switch to thumbnail mode, if necessary, by selecting Thumbnails from the View menu.

2 In the network tree, double-click the icon for the volume of interest.

The main view area displays the projects contained by the selected volume.

3 Continue browsing the contents of the current host:

■ Double-click any icon to open it.

■ Double-click a clip thumbnail to switch the main view area to player mode and load the clip into
the player.

■ To navigate back up the tree or to switch hosts, select another node in the network tree.

Playing Thumbnail Previews
Icons and thumbnails in the main view area provide an intuitive means to navigate the network and volumes.
More importantly, the thumbnails provide you with:

■ Metadata corresponding to each clip, including the clip’s name, timecode, duration, and tracks.
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■ A playable, scrubbable representation of the clip.

■ A gateway to loading the clip directly into the player.

To play thumbnail previews in the main view area:

1 Navigate to the clip of interest.

By default, a single-image thumbnail is automatically generated for each clip in the main view area.

a b d

e f

c

g

(a) Current timecode (b) Duration (c) Audio track indicator (d)Video track indicator (e) Clip name (f) Scrubbable
progress bar icon (g) Play/Pause icon

2 Click the progress bar to generate the playable thumbnail.

Thumbnail generation is normally faster than real-time, depending on the network interface and
processing power of the WiretapCentral server. Thumbnails are partially playable and scrubbable even
when processing or downloading is not yet complete.

The meaning of the different colours is explained below.

DescriptionTime Bar Colour

Thumbnail is not yet encoded.orange corkscrew

A grey progress bar indicates thumbnail is being generated. Grey from start-to-finish
indicates thumbnail is generated and resides in your browser’s cache.

grey

Playable thumbnail has been generated on the server, but remains to be downloaded
into your cache.

blue

Indicates position when playing or scrubbing.yellow

3 Play the thumbnail by clicking the Play icon.

4 Scrub the thumbnail by dragging over the progress bar.

Browsing Using the List View
By default, the main view area displays the contents of the current library or reel as clip thumbnails. The
list view presents an alternative view, presenting clips in table format, with sortable, repositionable columns.
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The list view allows you to locate or compare clips based on clip metadata, such as name, tape name, and
duration.

When used in conjunction with the Selection menu Expand Children command, you can list all the clips
in all ‘subdirectories’, as well as the library structure, of any network object — host, volume, project, library
or reel — in one click.

Browsing and Viewing Clips in the List View
The list view presents clip metadata in a sortable table with repositionable columns.

To browse and view clips using the list view:

1 In the network tree, navigate to the library or reel of interest.

2 From the View menu, select List View.

The list of clips contained in the library or reel appears in the list view. The list view contains one row
for each clip in the current library or reel.

3 Optional: Rearrange columns by dragging them to their new position.

4 Optional: Sort the list by clicking a column header.

5 Select a row to view its thumbnail in the Clip Details area.

6 Optional: Expand the selection of any network item — a host, volume, project, library or reel — all at
once. From the Selection menu, click Expand Children.

A confirmation dialog appears, cautioning you that the operation can take some time.

7 Click OK in the dialog.

This populates the list view with information on all nodes found in the sub-hierarchy, including clips,
reels, libraries, and projects.

■ In the Network tree, a spinning cursor indicates the recursive scan is in process. All sub-items are
expanded.

■ As the scan proceeds, the list view is populated by the incoming stream of metadata.

■ Once complete, the results persist until you select something else in the Network tree. However, the
data is cached locally for the duration of the session. The second time you expand the selection in
the same place the results are loaded immediately.

8 To switch back to thumbnail mode, from the View menu, select Thumbnails.
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Using the Player
Thumbnails are convenient for previewing clips, but the player is larger and offers considerably more playback
options. It presents clips at a width of 720 pixels, and usually at 100% JPEG quality. In addition, the player
has controls for stepping through the action, looping, and playing backward.

From most areas of the user interface, double-clicking a clip opens the player and loads the clip into it.
WiretapCentral automatically generates and downloads the high-resolution version from the clip on the
volume, then streams the playable version to the player. For long clips, this can take a few seconds, depending
on the network interface and processing power of the WiretapCentral server. If the clip has an NTSC or PAL
proxy on the volume, the process is usually very close to real-time. As with thumbnails, you can begin
playing as soon as the clip begins downloading.

Loading a Clip into the Player

To load a clip into the player:

1 Navigate to the clip of interest.

2 Double-click on the clip to open the player and load the clip. You can double-click a thumbnail or a
row in the list view.

The player appears in the main view area with the clip loaded.

The progress bar indicates how much of the clip has been downloaded. Clips in the player are partially
playable and scrubbable even when processing or downloading is not yet complete.

The meaning of the different colours in the time bar is explained below.

DescriptionTime Bar Colour

Clip is not yet playable.orange corkscrew

A grey progress bar indicates a playable clip is being generated. Grey from start-to-
finish indicates the clip is generated and resides in your browser’s cache.

grey

Playable clip has been generated on the server, but remains to be downloaded into
your cache.

blue

Indicates position when playing or scrubbing.yellow

3 To switch back to the previous view mode, from the View menu, select either Thumbnails or List View.

Playing a Clip
You can play a clip using the player controls, as shown in the following diagrams.
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a b c d

(a) Loop/mute/smooth display (b) Playback controls (c) Time bar (d) Zoom controls

The playback controls are detailed below.

a b c d e f g h

(a) First frame of clip (b) Back one frame (c) Fast
backward (d) Pause (e) Play (f) Fast forward (g)
Forward one frame (h) Last frame of clip

Panning and Zooming a Clip
You can pan the clip across the canvas and zoom in and out, even while the clip is playing.

To pan and zoom a clip:

1 To pan the clip, drag it using the mouse.

2 To zoom in and out:

■ Click the [+] and [-] UI buttons.

■ Use the wheel on the mouse.

3 To reset the player’s default pan and zoom settings, click Home.

4 To fit the clip to the available player canvas, click Fit.
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Decoding RED Media

Topics in this chapter:

■ About Importing RED Media on page 15
■ Importing RED R3D Media Files on page 16
■ Importing FCP XML Containing RED Media Files on page 18
■ Importing an EDL Containing RED Media Files on page 21
■ Adjusting the Settings on page 24
■ Defining the Output Destination on page 28
■ Submitting the Job on page 30
■ Monitoring the Job on page 31

About Importing RED Media
RED digital cameras record RAW media that is compressed using a proprietary codec known as REDCODE™,
which is saved as an R3D™ file. R3D files contain very high-resolution digital images (2K, 4K, or even higher).
These files require a computational-intensive debayering process to transcode to a file format that can be
read by Autodesk Visual Effects and Finishing applications.

WiretapCentral can prepare a reel of clips, originating from RED source material, for conforming in an
Autodesk Visual Effects and Finishing application. WiretapCentral is used to set up R3D transcoding jobs,
which are sent to a Backburner network for decoding, leveraging a network of processing nodes (any
Linux®-based computers, including the application workstation) to provide maximum processing speed.
The jobs output image sequences to a location that is accessible to Autodesk Visual Effects and Finishing
applications.

RED media can be imported as individual R3D files, or as either Apple® Final Cut Pro® XML or generic EDL
files that contain RED media.

3
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Importing RED R3D Media Files
RED media can be imported as individual R3D files.

1 In WiretapCentral, from the Import menu, select RED.

This starts a new import job. The Import Red window appears.

2 Enter a session name. Special characters are prohibited.

The session name identifies your import job when saving or loading a session, and when outputting
the job. It is also the job name in Backburner Manager.

3 Optional: Save the session. At any time, you can save a session. From the Session button, select Save or
Save As. Use the Session button to load a previously saved Import Red session or delete one.

WARNING Sessions are saved as cookies. Deleting your browser cookies deletes your saved sessions. On
Mozilla® Firefox®, using the Clear Recent History option deletes the browser cookies.

4 Ensure that the Input tab is selected.

5 From the Input tab, ensure that the R3D Files tab is selected.

6 From the R3D Files tab, select the Timecode to use.
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7 From the R3D Files tab, click Select Clips.

A browser appears.

8 By browsing through a Wiretap Gateway, select one or more RED clips and click Add.

Select multiple files at a time by using the Shift or Ctrl key.

The number of clips selected is displayed at the bottom of the screen.

9 When you are finished, click Done.

The selected clips appear in the Input list.

NOTE To verify the timecode used: if the Src TC columns matches either Edgecode or TOD TC (time of day)
columns, the clip will be imported using the matching timecode. If it matches neither, the clip will be imported
using the primary timecode.

10 When you are ready to proceed, click the Settings tab.

See Adjusting the Settings on page 24.
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Importing FCP XML Containing RED Media Files
If you are importing an FCP XML pointing to RED media, then you must make sure to take the right steps
in Final Cut Pro.

Working in Final Cut Pro
For interoperability with FCP, there are a minimal number of steps that must be performed before importing
into WiretapCentral.

1 Ensure that the original R3D files are stored in a location that is accessible to FCP.

2 Using REDRUSHES™, convert the R3D files into the QuickTime® DVCPRO HD format. Use DVCPRO720
and burn-in the timecode.

This is a less CPU-taxing format that you can easily import into Autodesk Visual Effects, Finishing, or
Grading applications, and keep your entire edit, audio included, as a reference.

NOTE Do not modify the R3D filenames. Instead, use the various comment columns to identify your clips.
Make sure that you keep the full 16-character filename as a reel name.

3 Edit in FCP using the QuickTime files (created in step 2) that contain the full original R3D filename.
Be aware that the FCP XML file will be used in your Autodesk Visual Effects, Finishing, or Grading
application, and that not all transitions, effects, and speed changes are supported. Consult your Autodesk
Visual Effects, Finishing, or Grading application user guide.

4 Export an FCP XML of the final sequence for use in your Autodesk Visual Effects, Finishing, or Grading
application.

1 Select the sequence in the FCP browser.

2 Choose File > Export > XML.

3 Select Apple XML Interchange Format, version 4.

■ Do not select Include Master Clips Outside Selection.

■ Select Save project with latest clip metadata (recommended).

The generated XML file points to the QuickTime files that you used for your offline editing.

5 Copy the source R3D files, the QuickTime files, and the FCP XML to a media folder on a SAN or NFS.
Ensure that:

■ The media folder is accessible from both WiretapCentral and your Autodesk Visual Effects, Finishing,
and Grading application.

■ You keep the same file/folder hierarchy where one folder contains all .RDM and .RDC folders and
subfolders. It makes it easier to search for and match events to media when loading the FCP XML.

■ You place the FCP XML in the top folder. This enables WiretapCentral to find automatically the
underlying media during the import process.

Avoiding the Log&Transfer Tool
If you use the Log&Transfer tool to ingest R3D files, the Reel name of the imported clips has a directory
name. You will then have to manually rename each Reel to their 16-character RED filename.
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Also, the Log&Transfer tool often imports only parts of clips over 4 GB, dividing them up while adding a
“_1”, “_2” to the filename, which hinders relink operations later on.

Examples of faulty filenames: A clip named A001_C004_0206T9, imported in FCP using Log&Transfer, is
renamed A001_C004_0206T10. A clip named A001_C004_0206TB, imported in FCP using Log&Transfer, is
renamed A001_C004_0206TB1.

Using the xml_adsk_tapename Script

The QuickTime files created in REDCINE™ have tape names that match the first four characters of the R3D
filenames, such as A001. But WiretapCentral requires the full 16-character tape names. If you edit in FCP
and export an XML with those QuickTime files, you need to convert the tape names back to 16-character
format. Use the Python script installed by WiretapCentral to perform this conversion.

The Python script is located in the /usr/discreet/wiretapcentral/scripts/ directory. Use it to process the FCP XML:
it replaces the four-character tape names with the ones extracted from the header of the QuickTime file.
You can then use the FCP XML in WiretapCentral.

The script creates a new copy of the processed XML file. To use it, put the script in a same directory as the
FCP XML file and type:

python xml_adsk_tapename.py name_of_the_file_to_modify.xml
name_of_the_destination_file.xml

For example, to modify the tape names in abc.xml, navigate to the directory containing abc.xml and type:

python xml_adsk_tapename.py abc.xml abc_fixed.xml

Importing FCP XML
RED media can be imported as FCP XML pointing to R3D files.

1 In WiretapCentral, from the Import menu, select Red.

This starts a new import job. The Import Red window appears.

2 Enter a session name. Special characters are prohibited.

The session name identifies your import job when saving or loading a session, and when outputting
the job. It is also the job name in Backburner Manager.
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3 Optional: Save the session. At any time, you can save a session. From the Session button, select Save or
Save As. Use the Session button to load a previously saved Import Red session or delete one.

WARNING Sessions are saved as cookies. Deleting your browser cookies deletes your saved sessions. On
Firefox, using the Clear Recent History option deletes the browser cookies.

4 Ensure that the Input tab is selected.

5 From the Input tab, select the FCP XML tab.

6 From the FCP XML tab, click Load XML File.

A browser appears.

7 Navigate to the folder containing the FCP XML file to be imported, and select the file.

8 Click OK.

The events from the selected XML file appear in the Input list.

9 Select the Timecode to use.

10 Click Search for Sources to have WiretapCentral search the contents of a folder for the sources. A browser
appears.

11 Navigate to the folder containing the R3D files. The files themselves are not displayed.

12 Select the location of the RED media files and click OK. WiretapCentral searches the folder and all
subfolders for each clip referenced in the XML.

In the list, the Status of each event with a located source changes from Missing to Found.

13 Optional: For each event with the Missing status:

1 Select the event for which to locate an R3D file.

2 Click Locate Source. A browser appears.

3 Navigate to the R3D file, and select it.

4 Click OK to link the R3D file to the event.

In the list, the Status of the event changes from Missing to Found.
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NOTE To verify the timecode used: if the Src TC columns matches either Edgecode or TOD TC (time of day)
columns, the clip will be imported using the matching timecode. If it matches neither, the clip will be imported
using the primary timecode.

14 When you are ready to proceed, click the Settings tab. See Adjusting the Settings on page 24.

Importing an EDL Containing RED Media Files
If you are importing an EDL file pointing to RED media, then you must make sure to take the right steps in
your editing application.

Working in Avid
If you are editing in your Avid® application, you will need to export EDL sequences, since WiretapCentral
does not support AAF.

Keep in mind that you will need to export one or more EDLs, so limit your edit to one video track. If you
must edit using several tracks, you will have to make as many duplicates of your sequence as you have video
tracks and remove any additional video from the duplicates. You will end up with several EDL files, one per
video track.

NOTE When editing in Avid Media Composer®, export an EDL using Avid EDL Manager and the RED16 template
(available at www.avid.com/red). The tape name of each event then has the required 16 characters. Use the
Python script provided with WiretapCentral to modify the Avid EDL and build a tape source table which works in
WiretapCentral and in your Autodesk Visual Effects and Finishing software.

To export EDL files:

1 Edit your sequence in your Avid application.

2 Pare down your Avid sequence to make it more EDL-friendly.

3 Make as many duplicates of your sequence as you have tracks, and prepare video-only sequences,
carefully naming each one.

4 Export each Avid sequence as a new EDL with the Avid EDL Manager using the following settings:

■ Set EDL type to RED16.

■ In the Options menu, set Reel ID Type to Cameraroll.

■ If Edgecode was used instead of TOD Timecode, set the Source TC option to Auxiliary TC 1.

■ Select the option that includes the source table with the saved EDL.

5 Repeat step 4 for each video track’s corresponding sequence.

6 Copy the source R3D files, the fixed EDL to a media folder on a SAN or NFS. Ensure that:

■ The media folder is accessible from both WiretapCentral and your Autodesk Visual Effects, Finishing,
and Grading application.

■ You keep the same file/folder hierarchy where one folder contains all .RDM and .RDC folders and
subfolders. It makes it easier to search for and match events to media when loading the EDL file.

■ You place the EDL in the top folder. This enables WiretapCentral to find automatically the underlying
media during the import process.
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Using the edl_adsk_tapename Script
The Avid RED16 EDL Manager template has the EDL source table and the tape name of each event which
uses the full 16-character tape name. But the EDL parsing mechanism in WiretapCentral reads standard
CMX events with tape names containing 8 characters or less. It also reads the tape source table.

WiretapCentral installs a Python script, which converts the events and the source table into a format
compatible with WiretapCentral and Autodesk Visual Effects and Finishing systems.

The Python script is located in the /usr/discreet/wiretapcentral/scripts/ directory. It creates a new copy of the
processed EDL. To use it, put the script in a same directory as the Avid EDL file and type:

python edl_adsk_tapename.py name_of_the_file_to_modify.edl
name_of_the_destination_file.edl

For example, to modify the tape names in abc.edl, navigate to the directory containing abc.edl and type:

python xml_adsk_tapename.py abc.edl abc_fixed.edl

Importing the EDL
RED media can be imported as generic EDLs containing R3D files. The workflow goes as follows.

1 In WiretapCentral, from the Import menu, select Red.

This will start a new import job. The Import Red window appears.

2 Enter a session name. Special characters are prohibited.

The session name identifies your import job when saving or loading a session, and when outputting
the job. It is also the job name in Backburner Manager.

3 Optional: Save the session. At any time, you can save a session. From the Session button, select Save or
Save As. Use the Session button to load a previously saved Import Red session or delete one.

WARNING Sessions are saved as cookies. Deleting your browser cookies deletes your saved sessions. On
Firefox, using the Clear Recent History option deletes the browser cookies.

4 Ensure that the Input tab is selected.

5 From the Input tab, select the EDL tab.

6 Select the Time Base for your EDL.

You must manually define the timeline’s time base before importing the EDL as the EDL does not this
information.

7 Select how Tape Name is written in the EDL.
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If there is a tape name conversion, and the original tape name is written below each event,
WiretapCentral shows the correct tape name. In the end you must have both the Source Name and
Tape Name fields containing the same data.

8 Click Load EDL File. A browser appears.

9 Navigate to the folder containing the EDL file to be imported, and select the file.

10 Click OK.

The events from the selected EDL file appear in the Input list.

11 Select the Timecode to use.

12 Click Search for Sources to have WiretapCentral search the contents of a folder for the sources. A browser
appears.

13 Navigate to the folder containing the R3D files. The files themselves are not displayed.

14 Select the location of the RED media files and click OK. WiretapCentral searches the folder and all
subfolders for each clip referenced in the EDL.

In the list, the Status of each event with a located source changes from Missing to Found.

15 Optional: For each event with the Missing status:

1 Select the event for which to locate an R3D file.

2 Click Locate Source. A browser appears.

3 Navigate to the R3D file, and select it.

4 Click OK to link the R3D file to the event.

In the list, the Status of the event changes from Missing to Found.

NOTE To verify the timecode used: if the Src TC columns matches either Edgecode or TOD TC (time of day)
columns, the clip will be imported using the matching timecode. If it matches neither, the clip will be imported
using the primary timecode.

16 When you are ready to proceed, click the Settings tab. See Adjusting the Settings on page 24.
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Adjusting the Settings
The Settings tab contains a number of parameters that can be set for the clips in your RED decoding session.
These are divided under the Format and the Color tabs. The settings under these tabs are the staging area
for the RED settings, and are not applied until you click the Apply button.

WiretapCentral reads the format and color metadata in the clip, as set in the camera, and populates the
parameters as appropriate. You can additively load presets, or change the settings manually.

Settings that are not changed are greyed out. Clicking one will activate all in the group. Settings that are
not enabled will not be applied.

The effects of the settings are displayed on the selected clip, in the Preview panel.

To modify clip settings:

1 Select the Settings tab.

2 In the list, select the one or more clips to edit.

3 Click Load Selected Clip.

The format and color metadata are loaded in the Format and Color tabs.

NOTE If you selected multiple clips, the tabs display only information about the first clip in the list.

4 Adjust the Format and Color settings. See Format Tab on page 25 and Color Tab on page 27.

5 Optional: To discard the changes, click Defaults.

6 Once the adjustements are complete, click Apply to save the modified settings.

Use Restore Camera Settings to restore the original camera settings.

Preview Panel
Use the Preview panel to monitor the changes to the Format and Color settings. You can also use the Preview
panel to set In and Out markers. These markers define the actual clip to import. They are disabled when
importing clips using an FCP XML or an EDL.

The image displayed in the Preview panel is a 1/8th resolution preview. Enable Full Resolution to view the
clip at full resolution.
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(a) In timecode (b) Start timecode (c) Mark In button (d) Go To In button (e) In-Out
duration field (f) Mark Out button (g) Go To Out button (h) End timecode (i) Out timecode

Format Tab
Use the Format Settings options to set:

■ Resize

■ Crop settings

■ Debayer quality

■ Detail level

■ Optical Low Pass Filter options

■ Denoise level
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Debayer  Select the level of quality required from the debayering algorithm. Higher resolutions take more
time to process.

Crop Enter the desired Crop settings. Setting crop values displays a matching crop box on the clip displayed
in the Preview panel.

Size W | H (Resize)  Enter the desired resize settings. A resize setting that is not directly proportional to
the size of the original media takes longer to process. Resize settings are automatically applied when Debayer
is set to something else than Full.

Bit Depth  RED media is 16 bits, but must be converted down to 12, 10 or 8 bits.

Fit/Stretch  To use a different aspect ratio during resize, select a fit method option to be applied to the
exported clip.

To:Select:

Fit the source image, centred, over the destination frame. If the source is larger than the destination,
it is cropped. If the source is smaller than the destination, it is surrounded by a black border.

Centre/Crop

Fit one edge of the source into the destination frame without stretching or squashing the frame. Excess
parts of the source frame after resizing are cropped.
If the source, after the one edge is resized, is wider than the destination, its overhanging left and right
edges are cropped. If the source is taller than the destination, the upper and lower edges are cropped.

Crop Edges

Fit the source, width, and height, into the destination frame. If the source and destination frames do
not have the same aspect ratio, the image can become distorted.

Fill

Fit the source to the destination frame without squashing or stretching it, and without cropping the
source.
If the source is wider than the destination, black bars fill the top and bottom of the destination frame.
If the source is narrower than the destination, black bars fill the right and left sides of the frame. In all
cases, the entire source frame is contained within the destination frame.

Letterbox

Filter  Select the filter option to determine the quality of the interpolated resize result.

To get:Select:

Quick, low-quality results.Impulse

Moderate results with little processing overhead.Triangle

Best results when resizing a clip to a higher resolution.Mitchell

Very good results for resizing soft-looking images. Use to sharpen the image.Bicubic

Good results for resizing simple images with straight edges. Similar to Gaussian but with more blurring.
Use to soften the image.

Quadratic

Excellent results when resizing a clip with no patterns and a lot of straight edges to a lower resolution.
Useful for softening some detail.

Gaussian

Excellent results when resizing a clip to a lower resolution. Very similar to Lanczos, but results are a
little softer.

Shannon

Best results when resizing a clip containing a variety of patterns and elements to a lower resolution.
It is the most complex with the longest processing time.

Lanczos

Detail  Select the level of detail extraction required.
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OLPF  Select the level of Optical Low Pass Filter compensation to use. OLPF is a type of sharpening used
to compensate for the optical anti-aliasing filter, which can induce softening of the image during recording.

Denoise  Select the level of noise reduction applied to the debayered clip.

Color Tab
WiretapCentral supports most color options available in RED applications, such as RED Alert!™.

The Color Tab displays the settings for the clip metadata, as set in the camera. Alter these settings carefully,
since overiding some values may produce unexpected results.

Load the RSX look created in RED Alert! by clicking Restore RSX Settings. The RSX file of a clip must reside
in the same folder as the R3D file of that clip; this is the default behavior in RED Alert!.

NOTE The Color tab also contains settings for RGB Gain, as well as Color curve settings. We recommend that you
do not change the default settings unless you have prior experience with color management.

Color Science  Enables you to select whether to use the Color Science settings from version 2.x of the RED
codec, or the settings from version 3.x of the codec. Select the correct codec, depending on the version of
the camera firmware used when shooting the footage.

Gamma Curve  Displays the value of the output gamma curve that is applied to the clips.

Color Space  Displays the value of the native color space of the images, as set in the camera.

ISO  Displays the value of the linear gain operation. Red images are always shot at 320 ISO.

Kelvin  Displays the perceived color temperature of the image.

Exposure  Displays the exposure increments, which are equivalent to f-stops.

DRX  Displays the setting for Dynamix Range Extension, which sets how much pixel data is copied from
non-saturated channels into saturated channels.
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Defining the Output Destination
Use the Output tab to change how timecode is used in the clip, to use handles, and to set one or more output
destinations for your import RED job. A job can be sent to multiple destinations. The decoding is done once
and streamed simultaneously to each location.

WARNING Be careful when transcoding to a StandardFS volume: if a file with the same name already exists in
the destination folder, it will be overwritten with the newer file.

The clip placeholder is created right away and the media is populated in the background without locking
the clip library in your Autodesk Visual Effects and Finishing application.

1 Click the Output tab.

The output options appear.

2 Click Add to add a destination for the given jobs.

A browser appears.

3 Select one or more destination locations for the processed clips.
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Depending on whether the destination is a StoneFS or a standard, unmanaged filesystem, different
kinds of images sequences will be created.

■ If the selected destination is a StoneFS on an Autodesk Visual Effects and Finishing workstation,
uncompressed RGB images are generated and the corresponding clips are created in
Project/Library/Reel. Clips are named according to their source R3D file name.

■ If the selected destination is on a Wiretap Gateway server, then stand-alone DPX sequences are
created in Main folder/Resolution.

WARNING If a file with the same name already exists in the destination folder, it will be overwritten with
the newer file.

NOTE You should create a folder using the project name to identify your clips.

4 To create a new library, select a project then, from the Tools menu, select New Library.

5 To create a new reel, select a library then, from the Tools menu, select New Reel.

6 Select a destination and then select New Reel from the Tools menu.

The DPX file name is always timecode-based, and is padded to 7 digits. Metadata is maintained in the
DPX header. Other metadata gets written into the XML file that WiretapCentral produces for each clip.

DPX sequences can be imported directly into Lustre, or as clips in Autodesk Visual Effects and Finishing
applications.

7 When done, click OK.

The selected destinations appear in the Output list.

8 Optional: Set Handles.

In a conforming workflow, you may add extra frames to the heads and tails of clips to provide for
dissolves and other transitions during finishing. Always set handles when importing FCP XML, since
FCP sometimes adds an extra frame at the end of the last clip in the sequence which may cause problems
upon import. WiretapCentral automatically adds enough handles to cover for transitions such as
dissolves and wipes.
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Submitting the Job
Use the Submit tab to set your processing options and execute your job.

1 Click the Submit tab.

Set any of the following parameters.

Job Description  Enter the description that will appear in Backburner monitor.

Backburner Manager  WiretapCentral scans the local network for all available Backburner managers.
Select the one to which you want to send the Import Red job.

Server Group  Select the server group (if available) for the given Backburner manager. A server group
is a virtual arrangement of processing nodes. By default, a job will go to all servers (up to the server
limit), which may not be advantageous to your job or work environment. Server groups need to be set
up in Backburner if you have a processing farm. See the Backburner User Guide.

Max Server Count  Select the number of processing nodes to be used on the job.

Job Priority  Set the job priority that is used in Backburner Manager for queued processes.

Email Notification  Enter your e-mail address if you want to be notified of job completion or failure.

2 When done, click Submit Job.
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This sends the jobs to Backburner for processing. The job status (clip creation on all destinations and
submission of the job to Backburner manager) is displayed in the Status list.

Monitoring the Job
Use the Job Monitor tab to follow the progress of all your submitted jobs.

1 Click the Job Monitor tab.

All the currently submitted jobs are displayed along with their status.

See Monitoring the Decoding Jobs on page 43.

You can also open the Backburner monitor selected in the Destination pane by clicking Web Monitor.

2 When you are done, from the Session box, select Save to keep your session information, then close the
browser to end the session.
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Decoding OpenEXR Media

Topics in this chapter:

■ About Importing OpenEXR Media on page 33
■ Importing OpenEXR Media Files on page 33
■ Adjusting the Settings on page 36
■ Defining the Output Destination on page 37
■ Submitting the Job on page 39
■ Monitoring the Job on page 40

About Importing OpenEXR Media
OpenEXR files are designed to support multiple resolutions and additional channels, making them appealing
for compositing. Since OpenEXR can store arbitrary channels (such as specular, diffuse, alpha, RGB, normals,
etc) in one file, it takes away the need to store this information in separate files. However, to support all
these arbitrary OpenEXR channels in Autodesk Visual Effects andFinishing applications, they need to be
converted to separate sets of RGB clips upon import. These RGB files can then be modified and combined,
for example in Action, to reconstitute the final clip.

WiretapCentral is used to set up OpenEXR transcoding jobs, which are sent to a Backburner network for
encoding, leveraging a network of processing nodes (any Linux-based computers, including the application
workstation) to provide maximum processing speed. The jobs output RGB image sequences to a location
that is accessible to Autodesk Visual Effects, Finishing, and Grading applications.

NOTE Multi-channel OpenEXR sequences are imported as 16-bit float. OpenEXR sequences at 32-bit float are
converted to 16-bit float automatically.

Importing OpenEXR Media Files
OpenEXR media can be imported as individual multichannel files. The workflow goes as follows.
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1 In WiretapCentral, from the Import menu, select OpenEXR.

This will start a new import job. The Import OpenEXR window appears.

2 Enter a session name. Punctuation marks are prohibited. WiretapCentral indicates if the session name
is invalid. Correct the name before going any further.

The session name is used to identify your import job when saving or loading a session, and when
outputting the job. The session name is used as the job name in Backburner Manager.

You can save this session at any time. From the Session menu, select Save or Save As. From this menu,
you can also load a previously saved Import OpenEXR session or delete one.

3 Ensure that the Input tab is selected.

4 From the OpenEXR Files tab, click Select Sequences.

A browser appears.

5 By browsing through a Wiretap Gateway, select one or more clips and click Add.

You can select multiple files at a time by using the Shift or Ctrl key.
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For OpenEXR files containing multiple render passes, you can select the file, to select all render passes,
or double-click the file to show the contained render passes. The render passes can then be added
individually.

6 When you are finished, click Done.

The selected clips appear in the Input list.

7 When you are ready to proceed, click the Settings tab.

See Adjusting the Settings on page 36.
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Adjusting the Settings
The Settings tab contains a number of parameters that can be set for the clips in your OpenEXR decoding
session. These settings appear under the Format tab, and are the staging area for the OpenEXR settings. You
can additively load presets, or change the settings manually. The settings are not applied until you click the
Apply button.

Settings that are not changed are greyed out. Clicking one will activate all in the group. Settings that are
not enabled will not be applied.

When you are done adjusting, click Apply to apply the settings to the selected clips in the list. The settings
can be applied to all of the clips or to individual selections.

Format Tab
Use the Format Settings options to perform any resizing, including resize filter options.

Width / Height  Enter the desired resize settings.

Fit/Stretch  To use a different aspect ratio during resize, select a fit method option to be applied to the
exported clip.

To:Select:

Fit the source image, centred, over the destination frame. If the source is larger than the destination,
it is cropped. If the source is smaller than the destination, it is surrounded by a black border.

Centre/Crop

Fit one edge of the source into the destination frame without stretching or squashing the frame. Excess
parts of the source frame after resizing are cropped.
If the source—after the one edge is resized—is wider than the destination, its overhanging left and
right edges are cropped. If the source is taller than the destination, the upper and lower edges are
cropped.

Crop Edges

Fit the source, width and height, into the destination frame. If the source and destination frames do
not have the same aspect ratio, the image can become distorted.

Fill
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To:Select:

Fit the source to the destination frame without squashing or stretching it, and without cropping the
source.
If the source is wider than the destination, black bars fill the top and bottom of the destination frame.
If the source is narrower than the destination, black bars fill the right and left sides of the frame. In all
cases, the entire source frame is contained within the destination frame.

Letterbox

Filter  Select the filter option to determine the quality of the interpolated resize result.

To get:Select:

Quick, low-quality results.Impulse

Moderate results with little processing overhead.Triangle

Best results when resizing a clip to a higher resolution.Mitchell

Very good results for resizing soft-looking images. Use to sharpen the image.Bicubic

Good results for resizing simple images with straight edges. Similar to Gaussian but with more blurring.
Use to soften the image.

Quadratic

Excellent results when resizing a clip with no patterns and a lot of straight edges to a lower resolution.
Useful for softening some detail.

Gaussian

Excellent results when resizing a clip to a lower resolution. Very similar to Lanczos, but results are a
little softer.

Shannon

Best results when resizing a clip containing a variety of patterns and elements to a lower resolution.
It is the most complex with the longest processing time.

Lanczos

Defining the Output Destination
Use the Output tab to set one or more output destinations for your import OpenEXR job. A job can be sent
to multiple destinations. The decoding is done once and streamed simultaneously to each location.

The clip placeholder is created right away and the media is populated in the background without locking
the clip library in your Autodesk Visual Effects and Finishing application.

1 Click the Output tab.

The output options appear.
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2 Click Add to add a destination for the given jobs.

A browser appears.

3 Select one or more destination locations for the processed clips.

The destination can be any StoneFS on an Autodesk Visual Effects and Finishing workstation.
Uncompressed RGB images are generated and the corresponding clips are created in Project/Library/Reel.
Clips are named according to their source file name.

4 To create a new library, select a project then, from the Tools menu, select New Library.

5 To create a new reel, select a library then, from the Tools menu, select New Reel.

6 When done, click OK.

The selected destinations appear in the Output list.
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Submitting the Job
Use the Submit tab to set your processing options and execute your job.

1 Click the Submit tab.

Set any of the following parameters.

Job Description  Enter the description that will appear in Backburner monitor.

Backburner Manager  WiretapCentral scans the local network for all available Backburner managers.
Select the one to which you want to send the Import OpenEXR job.

Server Group  Select the server group (if available) for the given Backburner manager. A server group
is a virtual arrangement of processing nodes. By default, a job will go to all servers (up to the server
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limit), which may not be advantageous to your job or work environment. Server groups need to be set
up in Backburner if you have a processing farm. See the Backburner User Guide.

Max Server Count  Select the number of processing nodes to be used on the job.

Job Priority  Set the job priority that is used in Backburner Manager for queued processes.

Email Notification  Enter your e-mail address if you want to be notified of job completion or failure.

2 When done, click Submit Job.

This sends the jobs to Backburner for processing. The job status (clip creation on all destinations and
submission of the job to Backburner manager) is displayed in the Status list.

Monitoring the Job
Use the Job Monitor tab to follow the progress of all your submitted jobs.

1 Click the Job Monitor tab.

All the currently submitted jobs are displayed along with their status.
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See Monitoring the Decoding Jobs on page 43.

You can also open the Backburner monitor selected in the Destination pane by clicking Web Monitor.

2 When you are done, from the Session box, select Save to keep your session information, then close the
browser to end the session.

Monitoring the Job | 41



42



Monitoring the Decoding
Jobs

Topics in this chapter:

■ Overview on page 43
■ Understanding the Monitor User Interface on page 44
■ Viewing Job Details and Job Tasks on page 48

Overview
The monitor provided in the media import workflow is suitable for monitoring and controlling your own
recently submitted R3D and OpenEXR jobs. WiretapCentral also provides a more comprehensive monitor,
available directly from the Tools menu. It has all the features of the monitor embedded in the media import
workflow, plus additional tabs, for managing servers and server groups associated with the currently selected
Backburner Manager, and for modifying the job-handling behaviour of the Backburner Manager itself.

NOTE There are three monitors available in Backburner: The Backburner Windows® Monitor, Backburner Web
Monitor and WiretapCentral Backburner Monitor (described in this chapter). For a comparison of the three, see
the Backburner User Guide.

To gain access to the WiretapCentral Backburner Monitor:

1 From the Tools menu, select Backburner Monitor.

The WiretapCentral Backburner Monitor appears in a new browser window or tab (depending on your
browser settings).

2 From the Backburner Manager drop-down list, select the Backburner Manager of interest.

The information in the current tab is updated automatically.
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3 You can update the display manually by clicking the Refresh button, or you can set a refresh rate from
the Auto Refresh menu.

4 To perform an operation on a job, select the job in the Jobs tab, then select the desired operation from
the Action menu.

Shift-click or Ctrl-click to perform the same operation on more than one job at a time.

5 To view job details, double-click the job of interest.

User Access Control
By default, no user name or password is needed to use WiretapCentral, and all jobs submitted from
WiretapCentral to Backburner are owned by user “apache”. As a result, you can easily perform operations
on all WiretapCentral jobs on the Backburner network, including suspending, activating, and deleting jobs
submitted by other users. In addition, by default the user “apache” has administrator privileges over all
other Backburner jobs, too, such as Burn® jobs submitted by an Autodesk Visual Effects and Finishing
application. For information on setting up user access control, see the WiretapCentral and Wiretap Gateway
Installation and Configuration Guide.

Understanding the Monitor User Interface
The standalone monitor user interface features four tabs for viewing job, server, server group and manager
information respectively. This section describes each of these tabs.

Jobs Tab
The Jobs tab presents information relating to all jobs associated with the selected Backburner Manager. Use
it to view and control the decoding jobs submitted from WiretapCentral, as well as to view jobs submitted
to Backburner by other Autodesk Visual Effects and Finishing applications.
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The following table describes the operations available from the Action menu.

ToSelect

Open the Job Details window for the selected job. See Viewing Job Details and Job Tasks on
page 48.

Settings

Resume a suspended job from where it was halted. Tasks that were already completed are left
as-is, and are not redone.

Activate

Restart a suspended job and all its tasks from the beginning, setting the job status to waiting.Restart

Place the job on hold.Suspend

Remove the job from the job queue.Delete

The following table presents the information found in the Jobs tab.

DescriptionColumn

This corresponds to the session name specified when submitting the decoding job.Name

The current state of the job:Status
complete: Completed successfully.
active: Currently being serviced.
suspended: On hold.
idle: Not scheduled for service.
waiting: Ready, and waiting to be serviced.

Percentage of tasks that have been completed.% Done

The number of completed tasks and the total number of tasks for the job. For example “55/145”
indicates 55 out of 145 tasks for the job have been completed.

Tasks

The job priority, from 0 to 100. Zero is the highest priority. 100 means the job is suspended.
Default is 0.

Priority

The time at which the job was originally submitted, in the following format: YYYY-MM-DD
HH:MM:SS

Submitted

The time at which the job started, in the following format: YYYY-MM-DD HH:MM:SS. If the job
has not started, zeros appear for the values.

Started

The time duration consumed by the job (HH:MM:SS).Elapsed
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DescriptionColumn

The processing engine needed for the job. For example:
Burn: The Burn renderer.

Type

Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs.
mio: The MIO adapter is the processing engine responsible for carrying out transcoding jobs.
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used by the Wiretap SDK’s background I/O tool, wiretap_bgio_tool.

The name of the user that submitted the job. This value is set automatically by Backburner when
the job is first created. By default, all jobs submitted from WiretapCentral have an owner of
“apache”.

Owner

Servers Tab
The following table presents the information found on the Servers tab.

DescriptionColumn

Server name (host name)Name

A short description of the server, entered when the server was installedDescription

The current activity of the server:Status
absent: Server is no longer seen by the manager, possibly down.
active: Server is currently working on a job.
suspended: Server has been put on hold.
idle: Server is inactive.
error: Server is experiencing a problem.

A value in the range [0–1] indicating the performance level of the server, relative to other servers
on the same job. A score of 1 indicates this is the best-performing server.

Perf. Index

A comma-separated list of installed plug-ins and adapters, for example:Adapters
Burn: The Burn renderer.
Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs.
mio: The MIO adapter is the processing engine responsible for carrying out transcoding jobs.
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used by the Wiretap SDK’s background I/O tool, wiretap_bgio_tool.

Server Groups Tab
A server group is a collection of render nodes grouped together for the purpose of organizing a render farm.
It acts as a shortcut to multiple render nodes. By default, the Backburner Manager sends a job to all the
render nodes equipped with a suitable processing engine. When you submit a job to a server group, it is sent
to the render nodes within the group only, leaving those outside the group free for other uses.

The following table presents the information found in the Server Groups tab.

DescriptionColumn

The name of the server groupName

A comma-separated list of servers in the groupServers
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For more information on server groups, see the Autodesk Backburner User Guide.

Manager Tab
Use the Manager tab to set options related to the Backburner network, such logs, server assignments criteria,
job retries, and tasks performed when a job finishes.

DescriptionField

Sets the type of events shown in the log files.
Error: Fatal errors that halt the rendering of a job.

Logging Level

Warning: Non-fatal warning information. These are events that do not cause the application to
stop rendering a job.
Debug: Detailed information about TCP/IP packets and the current state of Backburner Manager
and the Backburner Servers.
Debug Extended: A more verbose listing than Debug.

The Backburner Manager can send job success/failure notification to the address submitted with
the job (or assigned to the job once it is in the queue). Use this field to indicate the server where
the smtp mailer daemon is running.
Changing this field affects all email notifications for the selected manager—not just those asso-
ciated with your own jobs.

Default Mail Server

Sets the maximum number of jobs the manager sends out simultaneously. The optimal setting
depends on the processor speed of the manager workstation, general job size, and overall network

Max Concurrent Jobs

speed. Generally, the default value of 4 is adequate. You can change this value in the following
situations:

■ Decrease this value when rendering jobs are large and/or Backburner is struggling to keep
up with jobs.

■ Increase this value when rendering jobs are small and/or Backburner has no trouble keeping
up.

NOTE Avoid increasing this value substantially. Too high a value may cause an increased number
of node timeouts, because the jobs are sent faster than the nodes can handle them. In such
cases, decrease the value.

The number of times the manager attempts to restart a failed task.Retry Count

The time between each retry.Time Between Retries

Specifies what happens to job parameters once the job has successfully completed.On Job Completion
Leave: Leave in the job list.
Archive after n days: Remove from the job list and place in the job archive after the specified
number of days. Set to 0 (zero) to archive the job immediately after its completion. Archiving
saves a job’s parameters; it does not, however, save rendered frames or source material.
Delete after n days: Remove from the job list after the specified number of days. Set to 0 (zero)
to delete the job immediately after its completion.
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Viewing Job Details and Job Tasks
Double-clicking on a job name opens the Job Details window where you can view additional information
about a job, including its associated tasks, where they have been sent for processing, and their status. The
top of the window displays the following information.

DescriptionField

The name of the job.Name

The processing engine required to complete the job. For example:
Burn: The Burn renderer.

Type

Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs.
mio: The MIO adapter is the processing engine responsible for carrying out transcoding jobs.
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used by the Wiretap SDK’s background I/O tool, wiretap_bgio_tool.

The job’s ID as assigned by the Backburner Manager.Node ID

General Info Tab
The following table describes the information found in the General Info tab.

DescriptionField

Job description as entered when the job was submittedDescription

The owner of the job, and the host from which it was submittedSubmitted By

The current state of the job:State
complete (%): Completed successfully. The percentage is set by the Backburner Manager as
each task is completed.
active: Currently being serviced.
suspended: On hold.
idle: Not scheduled for service.
waiting: Ready, and waiting to be serviced.

The job priority, from 0 to 100. Zero is the highest priority. 100 means the job is suspended.
Default is 0.

Priority

The address to which job completion or job failure notifications are sentEmail Notification
When using this feature, be sure to set the location of the mailer daemon too. See Manager Tab
on page 47.

List of jobs that must be completed before the selected job can be processedDependencies

The last error message for the most recent task (associated with the job) executed by the Back-
burner Manager

Last Task Error

Tasks Tab
The following table describes the information found in the Tasks tab.

DescriptionColumn

The task number for this taskID
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DescriptionColumn

The state of the task (active, complete, waiting, error)Status

The name of the server where the task is being executedServer

The time stamp at which the task was started (YYYY-MM-DD HH:MM:SS)Start Time

The time duration consumed by the task (HH:MM:SS.MS)Elapsed Time

The last execution error message associated with this taskLast Error

Server Assignment Tab
The Server Assignment tab allows you to view the servers assigned to the selected job. It also allows you to
assign new servers or server groups to currently active jobs. A filtering mechanism allows you to limit the
list of servers to those capable of handling the current job type only.

NOTE You can only modify server assignments for jobs having a status of active.

DescriptionField

Name of the server group to which the job was assigned. A server group is a collection of servers.
Only servers in the specified group will work on the job.

Assigned Server Group

Within a server group, the maximum number of render nodes made available for the job, as
specified when the job was submitted. Set to 0 (zero) to assign the job to all servers in the group.

Max Server Count

A comma-separated list of servers currently assigned to the job.Assigned Servers

Select this checkbox to list only the servers capable of handling the job.Filter on Job Type

Name of the server.Name

A checkbox indicating whether or not the listed server is assigned to the job. To add a new
server to the job, check a checkbox. Notice the Assigned Servers list is updated automatically.

Assigned to Job

A description of the server.Description

The current activity of the server:
absent: Server is no longer seen by the manager, possibly down.

Status

active: Server is currently working on a job.
suspended: Server has been put on hold.
idle: Server is inactive.
error: Problem on the server.

A value in the range [0–1] indicating the performance level of the server, relative to other servers
on the same job. A score of 1 indicates this is the best-performing server.

Perf. Index

The adapters installed on the server, for example:
Burn: The Burn renderer.

Adapters

Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs. For more information see the Autodesk
Backburner User Guide.
mio: The MIO adapter engine is responsible for transcoding some streaming media formats
(such as R3D and OpenEXR).
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DescriptionField

Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used internally by Autodesk Visual Effects and Finishing applications.

Advanced Info Tab
Some applications submit Backburner jobs with extended instructions for the processing engine. Use the
Advanced Info tab to view and modify these extended instructions.
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Encoding Clips

Topics in this chapter:

■ About Encoding Clips on page 51
■ Supported Export Codecs on page 52
■ Encoding Clips on page 52
■ Customizing Encoding Presets on page 56

About Encoding Clips
Encoding clips is a three-step process that is done within the Export window: you select the input clip, set
the processing options, and submit the job. Once the clip is encoded, you have the option of creating a
package (containing all the clips you created), to upload to a web server.

NOTE Only fully-rendered clips can be encoded.

WiretapCentral guarantees frame and timecode accuracy; however, it is important to note the following
limitations:

■ Video clips are not broadcast-quality

■ Clips are down-converted to 8-bit per channel RGB

■ Film clips lack colour management

■ All effects must be rendered

■ Audio must be mixed down to 2 tracks; all other tracks are ignored

With these limitations in mind, it is recommended that any client final approval be done using the final
delivery medium.
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WiretapCentral encodes clips on the server, and they remain there once complete. The default storage
capacity of this location is set at 20 GB. Once this capacity is reached, older clips are automatically deleted
to make room for the new.

To modify the capacity of the storage, edit the wiretapcentral.cfg configuration file located at
/var/www/html/WiretapCentral/ on Linux systems, or /Library/WebServer/Documents/WiretapCentral/ on Mac
OS® X systems. Under the Export section, uncomment the line: SizeGB=20 and set the size (in gigabytes).

Supported Export Codecs
WiretapCentral can export clips in the following formats.

CommentsCodec

Main, High. Use Main when you want to minimize the use of computing resources. This is
the setting used by QuickTime Pro. Use High for broadcast or disc storage at high-definition,
such as for HD DVD or Blu-Ray.

H.264

H.264 format for Apple® iPhone® and iPod Touch®iPod Touch/iPhone

H.264 format for video-capable iPod®iPod 5G

MPEG-4

MPEG-2

MPEG-1

Flash® VideoFLV

QuickTIme file using the Animation codecQT Animation

Raw PAL or NTSC DV streamDV (PAL or NTSC)

Microsoft® MPEG-4 version 2MS MPEG-4

Encoding Clips
Encode clips using the following procedure.

To encode a clip:

1 From the Export menu, choose Selected or Entire List.

The export window appears.
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2 Name the export session.

This name is used to create a subdirectory on the server to hold the encoded clips. If no Session name
is entered, the name of the first clip selected, when entering the export panel, is used.

You can save this session at any time. From the Presets menu, select Save or Save As. From this menu,
you can also load a previously saved session or delete one.

3 If you previously made a selection of clips, it will appear in the list. Otherwise, click Select.

A browser appears.
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4 Select one or more clips and click Add. When you are finished, click Done.

The selected clips appear in the Input Clips list.

5 Click the Output Settings tab and set your encoding options, as desired.

You can select multiple output widths.
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NOTE For information on defining the values of the steps in the Quality slider, see Customizing Encoding
Presets on page 56.

6 Click the Submit Job tab and click Export.

A progress bar appears to indicate how much of the job has completed.

7 Click Done to continue.

The Submit Job tab reappears with new options.
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8 Click View Content to open a new browser displaying the server directory containing the generated
clip.

The directory created on the server is based on the export session name.

WiretapCentral exports encoded clips to the following directory, as seen by a Web browser:

http://<hostname_or_IP>/wiretapcentral/export/<session_name>/

9 Click Create Package to add the clip, or clips, to a TAR file.

You can copy this path to the clipboard and then paste it in a browser to access the file.

You can also view this, and all created, packages. From the Export menu, click View Packages.

You should download the files once the encoding is complete to avoid losing them if the storage capacity
is reached.

10 When you are done, close the window.

You can also return to the previous tab to export other formats of the same clips.

Customizing Encoding Presets
When you submit an encoding job in the WiretapCentral UI, the WiretapCentral ffmpeg encoder is called
with a series of command-line parameters, depending on the codec preset and quality level selected in the
Export window.

These presets are stored in the export_presets.xml file, located at /var/www/html/wiretapcentral/presets/ on Linux
WiretapCentral server systems, or /Library/WebServer/Documents/WiretapCentral/ on Mac OS X WiretapCentral
server systems.

Each preset defines the audio and video encoding format and parameters, as well as the video encoding
quality.

WiretapCentral provides a number of useful default presets. Advanced users are encouraged to add new
presets, or modify existing presets to better suit their needs.

To modify encoding presets:

1 Open a terminal to the WiretapCentral server machine, and log in as root.
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2 Open the file export_presets.xmlfile in a text editor.

The file is located in the /var/www/html/wiretapcentral/presets/ directory on Linux systems, or in the
/Library/WebServer/Documents/WiretapCentral/ directory on Mac OS X systems.

■ Each encoding preset is defined by a <preset> node in the file.

■ Each <preset> node has an <audio> child node that defines the audio codec parameters, and a
<video> child node that defines the video codec parameters.

■ <audio> nodes have a <base> child node that defines audio encoding parameters.

■ <video> nodes have a <base> child node that defines most of the video encoding parameters,
as well as a number of <quality> child nodes that define the steps of the Quality slider in the
Export window for that preset.

3 Modify the parameters in the <base> nodes, as well as the number and values of <quality> nodes.
The number of <quality> nodes in the XML file for a preset will be reflected by the number of steps
in the Quality slider for the respective preset.

4 Save and close the export_presets.xml file, and refresh the Web browser that points to WiretapCentral.

NOTE Incorrect parameters may cause encoding jobs to fail. Read the information available online about ffmpeg
parameters before making changes.

If an encoding job fails without a clear error message after you have modified export preset settings, perform
the following procedure to obtain detailed error information from the codec.

To troubleshoot clip encoding:

1 In the Export window, click View Presets.

A new browser window opens to the
http://<hostname_or_IP>/wiretapcentral/export/<session_name>/ URL.

Where <session_name> is the name of the failed export job.

The list of files in the export session is displayed, including a file named info.txt .

2 Click the info.txt file.

The browser displays the contents of the file.

3 Locate the “Full command (execute as apache or root):” line at the end of the file.

The next line in the file contains the command and parameters that were sent by WiretapCentral to
the codec when attempting to encode the clip.

4 Select the entire line and copy it to the clipboard.

5 Log into the WiretapCentral server machine as root, paste the command, and run it.

The codec outputs detailed messages on the reason for the failure.

6 Refer to online ffmpeg discussion groups for information on how to troubleshoot the reported problems.
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